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This month’s meeting started with Art 

Bendick saying he didn’t have 

anything drastic to report, and this 

was followed by a discussion on 

malware, and sites from which to 

download anti-malware programs. 

 Terry MacLennan warned 

about a false “Adobe” update which 

is actually a virus. 

 After the usual break for 

cookies, coffee and pop, president 

Joe Fornero reported that 42 boxes 

for the Christmas Child program were 

packed and thanked club members 

for their participation and also for the 

club donation of five boxes. He will 

conduct the Christmas program with 

lots of prizes and games. There will 

also be a potluck lunch, to which 

spouses and significant others are 

invited. The club will supply  a meat 

and cheese tray, and attendees 

should bring a dish to pass. 

 Because of conflicts with 

other parties by both the Sterling and 

Dixon Senior Centers, our meeting 

has been moved ahead to the first 

Saturday, Dec. 3. 

 Joe read a card from Lois 

Langley, thanking the club members 

for the plant and card that Betty 

Beatty sent her in all our names. 

 The minutes for the October 

meeting were accepted as published 

and Myron Kliment  read his 

treasurer’s report, which also was 

accepted as read. 

 Terry gave a report on the 

happenings in the computer lab. He 

noted there will be no further classes 

M I N U T E S :   S C U G  C L U B  M E E T I N G   

N O V E M B E R  1 2  ,  2 0 1 1  

D E C E M B E R  2 0 1 1  
V O L U M E  T W E N T Y - O N E    

N U M B E R   T W E L V E  

I N S I D E  T H I S  I S S U E :  

   

M A Y  P R O G R A M  O N  

T W I T T E R  
3  

W H A T  A  N A S T Y  V I R U S  

C A N  D O  T O  Y O U R  

C O M P U T E R  

4 - 5  

O R A C L E  A N D  T H E  

F U T U R E  O F  O P E N  

O F F I C E . O R G  

6  

A R E  Y O U  S E C U R E ?  7 - 8  

A  H A P P I E R  L O N G E R  

L I F E ?  V O L U N T E E R !  
8  

   

      

U S E R  H E L P I N G  U S E R  

until March. Several donated 

computers have been updated and 

there may be a couple of them for 

sale after the Center staff decides 

whether or not they will need them. 

 Betty’s birthday was the day 

after the meeting, so she was 

serenaded with a rendition of the 

Happy Birthday song and also 

received a card signed by all present. 

 It was also reported that from 

now on, when members pay their 

dues they will receive a form to fill out 

and submit with there payment. The 

form will include a tear off receipt.  

This will hopefully eliminate confusion 

as to who has paid, because Myron 

won’t have to take time to write out a 

receipt for everyone. 

 A reminder was given that the 

potluck will start at noon, with Santa 

Joe’s program to follow. There will be 

no raffle next month. 

 The meeting was adjourned 

and the raffle for prizes was held. 

 It was then time for Rebeca 

Chirinos, who gave a thoroughly 

interesting program on different 

browsers anyone can access and 

much more. (For additional 

information on program, see Betty’s 

article on page 4) 

 Miss Chirinos has promised to 

come back if she has time next year. 

  

Respectfully submitted by  

Angela V. Rester, secretary 
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The November SCUG board 

meeting was held at Wendy's in 

Sterling on Thursday November 17, 

2011. Board members present 

were Joe Fornero, Myron Kliment, 

Betty Beatty, Art Bendick, Terry 

MacLennan, Joe Schmitt and Kent 

McNeill.   
 

Myron gave us the Treasury Report 

numbers from the November 

meeting.  Myron noted that 

donations to both the cookie 

basket and raffle were generous. It 

all helps the club and is 

appreciated.   
  
The board reviewed and approved 

the thank-you letter to be sent to 

Rebeca Chirinos.  Board members 

expressed their enjoyment of 

Rebeca's November presentation.  

 

The board discussed preparations 

for the December Christmas Party.  

It will occur on Saturday December 

3rd (the first Saturday of the 

month).  It will be a potluck and we 

will start eating at NOON.  The club 

will provide a meat and cheese 

tray, a variety of breads and 

condiments for sandwiches. The 

club will also provide paper plates, 

napkins and plastic utensils.  

Everyone is asked to bring a dish 

to pass. Members may bring a 

spouse or friend.  Santa Joe will be 

providing the entertainment as 

usual.  There will be games and 

lots of prizes. 

 

Terry filled us in on a project the 

WCSC Computer Lab has been 

busy with.  They are refurbishing 

computers that have been donated 

to the senior center.  These 

working computers will be given to 

people in need wanting a 

computer.  They also have some 

donated laptop computers that 

they are refurbishing.  These 

refurbished laptops will be sold to 
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raise money for the WCSC.      

We will be nominating officers in 

December and January with the 

election in January.   

 

SCUG dues will due in January 

and members can pay them in 

December too.  Joe is creating a 

form for all members to fill out 

when they pay their dues.  The 

form will include a tear-off receipt.  

The form will assure that we have 

up-to-date member information 

and will also help in processing 

the dues. 

 

The club is considering ideas for 

future programs.  Art will be doing 

January's program. He will be 

creating a DVD with lots of FREE 

programs for the members to 

experiment with.  Copies of the 

disc will be for sale at the January 

meeting at a reasonable price.  If 

anyone has an idea for a program 

they could give in 2012 or would 

like to recommend someone from 

the community to give a program 

please contact Joe or a board 

member. 

 

The meeting was adjourned on a 

motion by Betty Beatty and 

seconded by Myron Kliment. 

   
Respectfully submitted 

in the absence of  

Secretary Angela V. Rester, 

by Betty Beatty 

 

 

 

B O A R D  M E E T I N G  M I N U T E S   

F O R  N O V E M B E R  1 7 ,  2 0 1 1  

President’s Corner 

Well Christmas is fast 

approaching and our December 

meeting is a week early.  Santa 

Joe hasn’t found time to work 

on his program between 

preparation for the items to go 

in the shoe boxes for Operation 

Christmas Child and delivering 

them to Dixon, getting out the 

monthly newsletters and of 

course the mandatory 3PM 

naptime. But not to worry! 

Since the simpler questions 

and not as complicated music 

quiz worked better last year, we 

will go with something very 

similar this year.  But I know 

most of you memorize the 

location of the songs so I will 

use some different songs and 

artists. (As if we can remember 

what happened last week. what 

more a year ago.) It should be 

fun with lots of prizes. So be 

sure to invite your spouse or a 

friend and bring a dish to pass.  

We will be eating at noon. 

 

Also remember we will be 

nominating officers and board 

members for next year. If you 

are interested let someone 

know, so they can nominate 

you. 

 

 

  Prez Joe 

 

Remember that the Computer 

Lab will be closed during the 

business and the presentation 

time of our meetings, except to 

Lab personnel.   
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and Firefox extensions:  

https://addons.mozilla.org/en

-US/firefox/, and Google 

Chrome (http://

www.google.com/chrome) and 

Chrome extensions and apps 

(https://chrome.google.com/

webstore).  These are the 

major five browswers.  They 

each have various strengths 

and weaknesses and it's fun 

to experiment with these to 

see which one or ones you like 

the best. 

In this article I will discuss a 

few of the things she showed 

us that I am testing out. 

One of the first things she 

showed us was Zootool 

(http://zootool.com ).  It is a 

visual bookmarking service 

created by a young German 

startup company.  Think of 

Zootool as a zoo for your 

favorite images, videos, 

documents and links.  Put 

them in your "zoo" so you can 

come back and visit them 

again and you can also share 

them with your friends via 

Email, Facebook Twitter or 

Tumblr.  You do this by 

creating an account (free) and 

installing the Zootool browser 

extension by dragging the 

lasso tool/bookmarklet to 

your browser toolbar. It works 

with Google Chrome, Opera, 

Safari and Firefox (but not 

Internet Explorer).  Using this 

lasso tool/bookmarklet you 

can easily pick the parts of a 

web page you want to put in 

your zoo – maybe just an 

image or a paragraph, or you 

can select the whole page.  It 

lists all the items you’ve 

captured as thumbnails along 

with their web addresses 

giving you visual bookmarks. 

You can organize the items in 

your zoo by putting them in 

different "packs," these 

"packs" representing different 

collections.  It works great.  

The FREE version contains 

ads but Rebeca says they are 

not very distracting. Ads can 

be disabled in the paid 

version; the paid version also 

has more features then the 

free version.  Rebeca's 

Zootool page is a good 

example of what one can do 

with this useful tool. 

The next item I decided to 

explore was Evernote (http://

evernote.com ), the note-

taking service.  Evernote is a 

California based company.  As 

of July 2011 it had 11 million 

users. From the Evernote 

homepage I clicked on the 

Download Now button and 

downloaded and installed the 

software. I did have to set up 

an account online too – this is 

for use of the online portion of 

the product.  Evernote works 

with Windows and Internet 

Explorer and automatically 

installs a web clipping tool in 

Internet Explorer.  It puts a 

standalone program on your 

computer.  You can "type" 

notes into the Evernote 

program interface and store 

them there in your computer.  

I opened a web site and 

selected some text.  I found 

the "Add to Evernote 4" tool 

Rebeca Chirinos graciously 

accepted our invitation to do a 

program for our club.  And what a 

program it was.  The room was 

packed and all members present 

listened attentively to her every 

word.  She had a lot to tell us.  

Rebeca created two Zootool 

pages for her SCUG program, 

displaying thumbnails of the web 

sites she shared with us and a 

few more.  You can find it at 

http://zootool.com/user/rebeca/

type:all/pack:2011:%20an%

20internet%20odyssey/.  You will 

find 29 entries on these two 

pages.  The pages also include 

some useful websites that 

weren't mentioned so be sure to 

visit Rebeca's Zootool pages for 

2011: Internet Odyssey at the 

above link. 

She began with a movie that 

showcases how sophisticated 

modern browsers have become.  

By a simple movement of the 

mouse the strip becomes 

animated and the story comes to 

life – it looked very 3D.  However 

it only works correctly with 

computers that have Internet 

Explorer 9 installed – which only 

works with Vista and Windows 7.  

You can find the movie at:  

http://

www.nevermindthebullets.com. 

Rebeca spoke about alternatives 

to Internet Explorer and Safari 

(part of Mac OS and also 

available for Windows 

computers).  She mentioned 

Opera (http://www.opera.com/) 

and Opera extensions (https://

addons.opera.com/en/addons/

extensions/), Firefox (http://

www.mozilla.org/en-US/firefox/) 

TALKING ABOUT REBECA CHIRINOS’ 2011: INTERNET ODYSSEY 
By Betty Beatty 
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under the Tools Menu in IE.  I 

clicked this and my highlighted 

text was put into the Evernote 

program on my computer.  By 

pressing the sync icon the note 

was also put onto the online 

Evernote page which I can view 

from any computer online.  It 

also put an "Add to Evernote 4" 

in my Outlook mail program 

toobar so I can easily add notes 

from emails to it.  Notes can be 

sorted into folders, tagged, 

annotated, edited, given 

comments, etc.  The user 

interface is very intuitive and 

user friendly. Notes can include 

pictures and photographs too. 

Evernote is available for free; 

the free version is supported by 

advertising.  There is also a paid 

version with more features; 

advertising can be disabled on 

the paid version.  Both versions 

have limits to the amount of 

notes one can store. 

Instapaper (http://

www.instapaper.com) is a 

simple tool to save web pages 

for reading later.  I was amazed 

at how simple this was to set 

up.  Just go to the web site and 

give them your email address 

and a password and click the 

Create account button.  At 

which time you are taken to 

your Instapaper page where you 

are told to drag the "Read Later" 

bookmarklet to your bookmarks 

toolbar.  Then, the next time 

you're on a page that you want 

to read later, just click that 

"Read Later" bookmarklet and it 

will be added to your Instapaper 

reading list.  One can add 

folders to organize your articles. 

That's all there is to it. 

According to info on this site 

this is a one person operation.  

Marco Arment created it.  The site 

contains a very helpful FAQ page.  

This service is free on the web, 

there is an iPhone/iPad app for 

sale, advertisements on the site, 

and one can support the site by 

subscribing for $1/month with 

the option to hide 

advertisements.  I am impressed 

by this service.  

And the last one we will look at is 

KeePass (http://keepass.info).  

Rebeca didn't have time to show 

us this one but it is on her Zootool 

page and she did mention it to 

me in a follow-up email. KeePass 

is a FREE, open source, light-

weight and easy-to-use password 

manager.  KeyPass has so many 

features I cannot go into detail 

about all of them because it 

would fill up many pages so I will 

just mention a few of them.  You 

can install KeePass on your 

computer or you can put it on a 

USB stick and run it on Windows 

systems without installation. 

KeePass offers Strong Security 

via Advanced Encryption.  The 

program stores your passwords in 

a highly encrypted database.  It 

offers Multiple User Keys – one 

can use one master password for 

the complete database or one 

can use key files that you carry on 

a USB stick to access the 

password database.  Or you can 

use a combination of these two 

methods.  You can export or print 

the password list.  The list of 

features goes on and on – you get 

the idea.  The download page 

offers two editions – both are 

FREE:  Classic and Professional. 

The site includes an Edition 

Comparison Table to find the 

version that is right for you. I 

downloaded and installed the 

program from their web site 

and KeePass opened on my 

computer upon completion.  I 

immediately clicked on the 

Help menu to see how to 

proceed and their Help 

information opened online.  I 

chose the First Steps Tutorial 

from the menu on the left.  

This led me through creating 

a new database, adding an 

entry, using entries, saving 

the database and more.  A 

very user friendly dialog box 

pops up to enter your 

password information in.  

KeePass gives you groups/

categories that you can select 

from to enter your passwords 

into (General, Windows, 

Networks, Internet, eMail, and 

Homebanking).  You can also 

create new groups/

categories.  I entered my first 

password into the KeePass 

database.  To use the 

information I can right-click on 

the entry and several options 

appear.  I can copy and paste 

the username and password 

from the database.  I can drag 

and drop the fields into other 

windows.  One can also open 

the URL from within the data 

base – just right-click on it 

and chose Open.  Be sure and 

SAVE your database – click on 

the SAVE icon on the toolbar 

or File>Save.  That's it.  Now 

all I have to do is enter about 

another 100 plus password 

entries and I am set.   

I have just given some very brief 

sketches of these handy tools.  These 

programs are capable of much more 

than I have mentioned.  But it's a start 

and I encourage you to also try some of 

the very useful tools Rebeca showed us.   
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As I type more letters, the search is re-

fined and fewer names appear as the 

search criteria is refined. Note that the 

letter or word that I have typed appears 

high-lighted in the list of files. I also have 

the option of adding search filters to re-

strict my search  to a range of dates, file 

size, etc. In my example we see that a 

number of files match my brief search 

criteria, “win.” I could click on each of 

these files to see which one I want but 

Windows 7 gives us an easier way. I can 

point and click once on a file to highlight 

it, and then click on the “Preview” button 

in the upper right corner of the search 

window to see what’s inside of the file 

without actually opening it.  

By now I think you’re starting to 

see the value of libraries to find 

files. But suppose you have 

folders that are not in one of 

your libraries? For instance, I 

have folders of pictures stored 

on an external hard drive. All I 

have to do is click on the “Start” 

button, click on “Computer” and go to the 

icon for my external hard drive. After I click 

to open the hard drive, I select the folder 

containing my pictures and right-click. In 

the window that appears I select “Include 

in library.”  Among the library choices that 

appear I select the “Pictures.” Now the 

pictures on my external hard drive are 

included in my “Pictures” library and any 

search of the Pictures library will include 

them.  
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You can change where 

a library saves files and 

the order that it 

searches them. Just 

click the “Start” button 

and then one of the 

library names, such as 

“Pictures.”  In the li-

brary window, above 

the file list and next to 

“Includes,” click on 

“Locations.” A new win-

dow will open, in this 

example called “Picture Library Locations.” 

From here you can select/click on buttons 

to add or remove folders. Digital cameras 

often include image editing and storing 

software when you purchase them. Many 

times this software creates new folders to 

store the pictures from your camera. This 

“Add” button allows you to include your 

camera’s pictures folder in the Windows 7 

library so that they are easily searchable. In 

addition, if you right-click on a library folder, 

you can set it as the default folder, where 

all new related files will be added. You can 

also change the order in which the listed 

folders are searched.   

You may have noticed in the step above, in 

addition to selecting one 

of my default libraries, 

one of the options was to 

create a new library. Can 

you see how you might 

use this?  Suppose you 

had a folder for Genealogy 

records. You could select 

that folder and create a 

Genealogy library. Simi-

larly, you could select a 

folder which appears in 

your Pictures library that 

contains Genealogy re-

lated pictures and add it to your Genealogy 

library. Now you can access the Genealogy 

pictures through either your Pictures or 

Genealogy library. As you can see, libraries 

are a very powerful and useful tool. They 

provide an easy way to find the files you 

use most frequently without imposing a 

rigid organization structure. Next time we’ll 

look at  more ways you can find files and 

how to create new libraries.   

 

By Neil Stahfest, Vice President, Tacoma 

Area PC User Group, Washington  

March 2010 issue, the Data Line 

NCStahfest (at) msn.com 

www.tapcug.org 

 

This month we’re going to look at my 

favorite new Windows 7 features, file 

search and libraries. I confess, I used 

Windows 7 like Windows Vista for almost 

two months before I became aware of 

these features. If you’ve used previous 

versions of Windows, one the first things 

you will notice in Windows 7 is that there 

is no “Search” function listed on the Start  

menu. Instead, when you click on the 

Start button, a search box appears di-

rectly above the Start button, the normal 

Start Menu items above it. In addition, 

any time you open an Explorer window, a 

search box appears in the upper right-

hand corner.    

Libraries are a new Windows 7 feature. 

They make it easier to find things by 

keeping track of similar files, no matter 

where you store them. By default, Win-

dows 7 has four libraries: Documents, 

Pictures, Videos and Music (the Videos 

library doesn’t appear on the Start Menu 

but we’ll address that at another time). 

To find a document, I can click on the 

“Start” button and then “Documents.” 

This opens a window which shows my 

Documents library as shown below.  

 I could look for the document I want by 

opening folders but Windows 7 gives us 

an easier way. In the upper right corner of 

the library window is a search box. As I 

start to type the name of the document 

I’m looking for in the box, the list in the 

main window changes to reflect names 

that contain the letters or words that I 

have typed.  

 

Discovering Windows 7 – Part 4 
By Neil Stahfest  

http://www.tapcug.org
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If you create many documents in 

Word, you may find that you often 

include portions of text with similar 

content or format. For example, 

when preparing to submit SPCUG 

classes each month to the Monitor, 

I always include a list of the details: 

dates, day, time, location, instruc-

tor, and instructor’s email address. 

As I learned more about Word 

2007, I realized I could set up a 

skeleton format for these class 

postings and save it as a “building 

block” (aka Quick Part) in Word. 

When I needed to prepare a new 

class posting, all I had to do was 

insert this building block into a 

document after the class descrip-

tion and enter the specific details, 

saving me the hassle of recreating 

the format.  

New in Word 2007, building blocks 

are related to templates except they 

are bits of text, rather than a whole 

document. For user convenience, a 

complete set of pre-formatted build-

ing blocks is listed on the Insert tab 

in the Text group under “Quick 

Parts.” Click the Building Block or-

ganizer to find pre-formatted text 

boxes, headers and footers, cover 

pages, page numbers, and more. 

Many of these building block galler-

ies are also available under their 

own icons throughout Word. The 

Building Block organizer, however, 

includes all the categories in one 

place. You can insert any one of 

these blocks into a document or 

template by opening the document, 

placing the cursor where the block 

belongs, clicking the Insert tab, 

then Quick Parts, Building Block 

organizer, and the building block 

you want.  If that sequence seems 

too cumbersome, you can add the 

Building block organizer to the 

Quick Access menu. Right click the 

organizer title and select “Add to 

Quick Access toolbar.” 

 

Creating your own building blocks is 

easy and can save you lots of re-

petitive typing. The first step is to 

create a piece of formatted content. 

Let’s use the example of a logo 

which could be used in a letterhead, 

business card, and other documents. 

Since building blocks may contain 

many types of content, such as lines, 

images, drawings, and tables, as well 

as text, I created one using a table with 

text and a piece of clip art from the 

Word program. Here’s how it looks: 

 

My next step was saving the building 

block. I selected the logo, clicked the 

Insert tab, then Quick Parts, and chose 

“Save selection to Quick Parts gallery.” 

This action opened the “Create New 

Building Block” dialog box, where I 

gave my block a Name, OTS logo. In 

the Gallery area, I left it labeled ‘Quick 

Parts’ because it didn’t fit into any of 

the existing galleries.  Under Category, I 

created a new one called Nancy, which 

let me group all my custom building 

blocks together for easier access. I 

skipped Description, although if I had I 

added one, it would have become the 

Screen Tip for the block. I left the Save 

In and Options boxes as they were and 

clicked OK to save my changes. 

 

Now it was time to try adding my new 

building block to a document. I opened 

a blank document and double-clicked 

about half way down the page to posi-

tion the cursor there. Then I clicked the 

Quick Parts icon on the Insert tab, 

which showed previews of my last 

three custom building blocks. I clicked 

OTS logo and it appeared in the docu-

ment where my cursor had been. Had 

the block not been visible as a preview, 

I would have clicked Building Block 

organizer and scrolled to Quick Parts 

under the Gallery column to locate it.  

 

Next I decided to change the font in 

the logo heading. I knew that any build-

ing block can be modified in a docu-

ment without changing the version 

stored in the Building Block organizer. 

I changed the font of OTS logo from 

Goudy Stout to Bodoni MT black.  As 

an experiment, I saved the modified 

version to the Quick Parts gallery with 

the same name and properties as the 

first version to see if it would over-

write the original. I was surprised to 

find that it did not. I ended up with 

two different versions with the same 

name. I decided it is necessary either 

to delete a first version before saving 

a second or give the second version a 

different name. Finally, since the logo 

block was only for illustration pur-

poses, I decided to delete it. I simply 

opened the Building Block organizer, 

scrolled to and selected OTS logo, 

and clicked Delete. 

 

My own collection of custom building 

blocks includes a footer which in-

cludes my name, page number and 

current date; a copyright sign with my 

name; the SPCUG class detail list; 

and a personal logo I use as a letter-

head. I do, however, often select from 

the galleries of pre-formatted building 

blocks located on almost every tab of 

Word 2007; for example, watermarks 

on the Page Layout tab, cover pages 

and text boxes on the Insert tab, or 

Table of Contents and Bibliographies 

on the References tab. More building 

blocks are available at 

www.office.microsoft.com. 

 

The more I customize my Word 2007 

program, the easier tasks become. 

Creating custom Building Blocks is 

one more way to make Word 

2007/10 my own. 

 
By Nancy DeMarte, Columnist, Office 

Talk, Sarasota PCUG, Inc., FL 

October 2011 issue,  

Sarasota PC Monitor 

www.spcug.org 

ndemarte (at) Verizon.net 
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Rename Multiple Files at Once 

Did you ever have a bunch of files, 

folders or pictures with similar 

names like DSC_12234? They are 

so uninformative. So I used to open 

Picasa and do a batch rename... it 

worked. But here is a simpler way 

without opening up another pro-

gram. Highlight all the files/folder in 

question. Right-click, choose Re-

name and call it something that best 

describes them. For example, Family 

Picnic. Quick as a flash they are re-

named to a uniform more meaning-

ful name. The only thing I don’t like 

is that the sequential numbers are 

put in parenthesis while Picasa al-

lows you to set the numbering con-

vention. Either way you get rid of 

files called File1, File2, etc. 
 

Reformat a flash drive 

I think this is a tip that is not really 

needed, however there might be 

some of you who are wondering if 

you have the capability of reformat-

ting a flash drive. Well you do, and 

here is a reason you might want to. 

Lots of flash drives are formatted in 

FAT32. Today we know that a more 

space saving method is the format 

NTFS. So to pump up the drive to 

save a few more files you would 

want to change to the NTFS format. 

Actually, a flash drive can be refor-

matted the same way as any other 

drive. 
 

As we know, when you plug in a 

flash drive your computer automati-

cally assigns it a drive name and it 

looks like any other hard drive, so 

just go to “Computer,” right-click on 

the drive, and then click on 

“format.” You then have some op-

tions. File type should be NTFS (or 

FAT32 if available). You can then 

assign a name to the drive, and fi-

nally you can decide if you want full 

or quick format. The full format will 

take a lot of time and actually refor-
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mat the whole drive. The quick 

format just erases the File Index. 

It does not change any bytes on 

the drive. Then just click on 

“Start.” When done the “format 

will say complete.” 

 

Now, here are a couple of caveats 

you should be aware of. If the 

flash drive came with certain pro-

grams, such as security or mainte-

nance programs you might want 

to copy them to your hard drive 

during the format and copy them 

back over after the format is fin-

ished. A format destroys all data 

(or at least hides it from normal 

viewing). 
 

Also, there is some thought that 

reformatting will reduce the life of 

your flash drive. Does it? By how 

much? Hard to quantify, and even 

harder to decide if that actually 

does reduce the life of your drive. 

I really wouldn’t worry about that. 
 

Storing important files 

While on the subject, which is bet-

ter for storing an important file? 

Your computer hard drive? Exter-

nal drives? Or optical media such 

as CDs and DVDs? Where to store 

precious pictures or personal data 

is a serious question. How long 

will a disk or drive last? Will it fail? 

Will the medium become obso-

lete? (Anybody still remember 

floppy disks?) To answer this 

question, first we need to look at 

some of the qualities and limita-

tions which the most commonly 

available storage formats present. 
 

Storage Format: Hard Disk Drives 

Pros: Large storage capacity for 

the price / Typically good lifespan. 

Cons: Susceptible to malfunction 

due to mechanical failures and 

physical impact. 

 

The Tip corner 

By Bill Sheff 

Inside your computer (desktop 

or laptop) is probably the safest 

place to store your hard drive

(s,) but doing so will not guar-

antee a trouble free experi-

ence. Why? There are just too 

many moving parts. 
 

Inside the hard drive case are 

discs which spin as a mechani-

cal arm which moves back and 

forth above the disc surface, 

reading and writing data to and 

from the platters beneath. 

While this method of data stor-

age has worked for many, many 

years, there has always been 

one unavoidable fault which 

leads to inevitable failure of a 

hard drive...the aforementioned 

mechanical parts. As with any 

device which relies on constant 

and precise mechanical move-

ment to run, hard drive parts 

eventually fail, usually taking 

your data to the grave with 

them. Due to the precision with 

which they operate, hard im-

pacts may also cause a hard 

drive to read or write data in 

error, and possibly fail alto-

gether as well. Despite these 

shortcomings, most hard drives 

have a life expectancy of at 

least 3-5 years, with many re-

portedly living a healthy life at 

10+ years of age. 
 

Storage Format: Optical Media 

(CD-R / DVD-R) 

Pros: Inexpensive, portable 

Cons: Inconsistent lifespan, 

temperamental storage re-

quirements, data lost over time 

due to degradation 
 

Optical media are quite handy 

for short term storage of data. 

However, they remain a less 

than desirable choice for long 

term and mission critical data 

archival. The reason is simple: 
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everyday optical media de-

grades quickly and easily. Al-

though many manufacturers 

claim their optical media will last 

for 30 years or more under per-

fect conditions, their actual life-

span with normal use and stor-

age is typically closer to a few 

years (at most) than a few dec-

ades. There are many different 

factors which conspire against 

the lifespan of CD-R’s and DVD-

R’s; sub-par dyes (the reflective 

portion of a disc where data is 

written) which degrade much 

sooner than rated, exposure to 

heat, cold, or sunlight which also 

degrade said dyes, and weak or 

wrongly calibrated optical disc 

burners which fail to write data 

as intended. All of these factors 

make every day optical media 

formats a less than favorable 

storage choice; ok for short term 

data storage, but definitely not 

the choice for long term backup 

of important information. 
 

Storage Format: Flash Drives 

Pros: Durability, Versatility 

Cons: Debatable life span, 

higher price per gigabyte 
 

The last decade has given rise 

to the newest consumer storage 

devices in this comparison: solid 

state flash (aka thumb) drives. 

Unlike the aforementioned stor-

age mediums, flash drives use 

no moving parts or temperate 

dyes to store data, relying in-

stead on electrical pulses to 

write data to a static storage 

chip. This method of storage 

allows for much higher shock 

resistance and durability, as well 

as smaller form factors and in-

creased portability, than what is 

traditionally offered in a hard 

drive or CD/DVD. 
 

The downside to this fantastic 

usability is a generally higher 

T I P  C O R N E R  ( C O N T . )  

B Y  B I L L  S H E F F  
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price per mega/gigabyte [i.e. for the 

price of a 32GB flash drive, you 

could purchase a larger portable 

hard drive with a terabyte (1000 

gigabytes) of storage]. The life ex-

pectancy of flash drives is also up 

for debate, as the solid state mem-

ory used to store your data does 

wear out the more times you write 

to it. Good quality flash drives from 

well known, trusted manufacturers 

are typically agreed to have a life 

span of a few years or more, mak-

ing the flash drive a good choice for 

your everyday data storage needs. 
 

By now you’re probably thinking to 

yourself “should I use any of these 

formats to store my data?” The an-

swer is yes: use all of them. If you 

want to sleep soundly at night with-

out worrying about your irreplace-

able pictures, videos, documents, 

etc., regularly backup your impor-

tant data on at least two sources; 

creating duplicates which will 

allow you to retrieve your important 

information should any one backup 

fail completely. And keep in mind, 

as newer methods arrive, such as 

Blu-ray disks or bubble memory or 

cheaper solid state drives, the older 

methods such as CDs and DVDs 

start fading away. As I asked earlier, 

“Remember the floppy drives?” I 

gave away hundreds of 5 ¼ flop-

pies, and still have hundreds of 3 ½ 

drives. Anybody still have a drive to 

run them on??  

 

 
By Bill Sheff, Novice SIG Coordinator, Lehigh 

Valley Computer Group, PA 

October 2011 issue, The LVCG Journal 

www.lvcg.org 

Nsheff (at) aol.com 

Word: Change Save Format 

By default, Word 2010 saves 

to the DOCX format. If you 

regularly save documents to a 

different format (such as DOC, 

the format used by older 

versions of Word), you can 

make that format the default. 

Click the File tab and then click 

Options. Click the Save tab and 

then click the drop-down menu 

next to Save Files In This 

Format. Finally, click the OK 

button.  

 

Turn Off Auto Formatting 

If you’ve ever created a 

numbered or bulleted list in 

Microsoft Word, you know that 

Word automatically makes 

formatting changes once it 

senses a pattern in your list. 

However, the auto-formatted 

text can become tedious to 

change when you want to 

begin a sentence with a 

number or bullet point without 

beginning a new list. If you 

want to turn off auto 

formatting in Word 2003, click 

the Tools menu, select 

AutoCorrect Options, choose 

the AutoFormat As You Type 

tab; remove the checkmarks 

from the Automatic Bulleted 

Lists and Automatic Numbered 

Lists, and click Apply. In Word 

2007, click the Office button, 

Word Options, and Proofing; 

click the AutoCorrect Options 

button; select the AutoFormat 

As You Type button; remove 

the checkmarks from the 

Automatic Bulleted Lists and 

Automatic Numbered Lists, 

click OK, and click OK again.  
(Continued on page 9) 

T I P S  O F  T H E   

D A Y  

http://www.lvcg.org
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situations are similar.  I 

recognize the benefits of the 

latest technology and highest 

performance, but I am 

generally thrifty and want to get 

the best value for my 

computing dollar.  I like the 

latest and greatest, but I’m 

usually not considered an 

“early adopter,” especially if 

the technology is expensive 

and unproven.  I don’t have 

extreme computing needs like 

gamers do; I don’t need the 

computer equivalent of a 

Ferrari, but am happy with a 

reliable though slightly sporty 

sedan.  I’ve never bought the 

latest or most powerful 

computer available, because 

those typically carry a premium 

price.  Rather than buying on 

the cutting edge, I prefer the 

middle of the blade, where 

economies of scale and the 

competition of many vendors 

has brought the price down a 

bit.  I try to keep my computers 

running as long as I can to get 

the most value out of their 

purchase, but if I didn’t pay 

quite so much in the first place, 

I feel less resistance to 

replacing for newer technology 

after a few years.  I’ve never 

actually had a computer fail 

(that could not be easily 

repaired), but I have gone 

through a string of machines 

replaced due to eventual poor 

performance or feature envy. 

 

By Greg Skalka, President, Under the 

Computer Hood User Group, CA 

October 2011 issue, Drive Light 

www.uchug.org 

president (at) uchug.org 

No matter what kind of 

computer you have, it is likely 

you will eventually need to 

replace it. The personal 

computer seems to have 

become an essential part of our 

everyday lives, providing 

information, communications, 

entertainment, education and 

organization. Computers can 

assist in all aspects of our 

financial lives, from searching 

for prospective employers on the 

web, creating a resume, 

managing your pay through 

online banking, tracking your 

finances and filing your income 

tax returns, to creating a will to 

pass your remaining wealth to 

the next generation.   

 

It seems the personal computer 

is something most people can’t 

do without. Yet our computers 

do break or wear out eventually.  

Regular maintenance and 

careful use can extend their 

useful lives, and user groups are 

great places to learn about ways 

to keep your computer running 

longer and get support for 

computer problems.  Even when 

perfectly maintained, however, 

the advance of technology has a 

way of quickly making your old 

computer seem slow, 

inadequate and behind the 

times.  At some point, it may be 

best to put the old machine out 

to pasture and get a more 

powerful, capable and reliable 

model. 

 

I’ve been thinking about new 

computers for a while, and my 

thoughts on the matter might be 

of help to others whose 

Case Toggling 

This is a function in Microsoft 

Word that you’ve been 

thinking about for a while; 

the ability to toggle through 

lower and upper cases. How 

often have you needed to 

capitalize a letter in a word or 

capitalized a letter by 

accident? Just highlight the 

letters or words in question 

and press SHIFT-F3. The 

case of the letters will 

alternate between all 

lowercase, capitalizing the 

first letter of each word, and 

all uppercase.  

 

Lightning Fast Lines 

A horizontal line spanning the 

width of a Word document 

can be helping in illustrating 

a clean break in a thought. 

AutoCorrect creates a 

number of different lines 

according to three characters 

you can type. If you type 

three consecutive hyphens, 

underscores, or equal signs 

and press enter, Word 

creates a line, bold line, or 

double line, respectively.  

 
 

Reprinted with permission from  

Smart Computing. Visit 

www.SmartComputing.com for 

more information.” 

 

I S  I T  T I M E  F O R  A  N E W  C O M P U T E R  

B Y  G R E G  S K A L K A  

T I P S  O F  T H E   

D A Y ( C O N T . )  

http://www.uchug.org
http://www.SmartComputing.com


Notice 

     The next meeting of  the  Sauk                                     

Computer  User Group will be  

December 3rd, 2011       

    Christmas Potluck: 12:00 PM                    

Business: 1:30 P.M.          

Program: 2:00 P.M. 

  Place: Whiteside Senior Center                                

 1207 West 9th Street                               

 Sterling, Illinois 61081 

O U R  D E C E M B E R  M E E T I N G  W I L L  B E G I N  A T  N O O N  O N  D E C E M B E R  3 R D .  I T ’ S  O U R  A N N U A L  

C H R I S T M A S  P A R T Y  S O  W E  W I L L  B E  H A V I N G  A  P O T L U C K  L U N C H .   P L E A S E  B R I N G  A  D I S H  T O  

P A S S .  I N V I T E  Y O U R  S P O U S E  O R  A  F R I E N D  .  S A N T A  J O E  W I L L  B E  T H E R E  S O  W E  A L L  C A N  E X P E C T  

T O  H A V E  L O T S  O F  F U N .   W E  W I L L  A L S O  B E  N O M I N A T I N G  O F F I C E R S .  

 

There will be a no Question &  

Answer  Session due to Christmas  

Party. 

 


